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Get the most from your time online

The new Netscape 7.0 fits the way you use the Web: fast, efficient browsing and e-
mail, the #1 instant messenger, one-click radio and much more.

Netscape 7.0 is optimized for the key things you do on the Web—browsing, searching, communicating,
shopping, downloading files, and playing music. It also gives you more control to customize your online
experience, and features that let you express your personality on the Web. Netscape 7.0 delivers enhanced
performance and stability with a fine-tuned Netscape Gecko browser engine that speeds the most common
online activities.

With Quick Launch, get online faster with Netscape 7.0. Within Navigator, convenient, timesaving new features
let you quickly browse multiple Web sites in a single window, and more easily print, search the Web, and
download files. Communicating on the Web is better than ever with Netscape 7.0. More powerful e-mail enables
you to efficiently organize and manage all your online communications. Integrated AOL® Instant MessengerTM

(AIM®) is always at your fingertips, and now lets you add personality to your messages with custom Buddy
Icons. Netscape 7.0 also includes the new integrated Radio@Netscape that lets you pick stations that suit your
style and play music right from the browser.

Download Free Netscape 7.0 today at http://browsers.netscape.com.

Netscape 7.0 builds on the key features of Netscape 6.2 and is a robust integrated suite of software that
includes:

� Navigator browser

� Mail & Newsgroups

� Address Book

� AOL Instant Messenger

� Composer web page editor

� Radio@Netscape

� Plug-ins

There are many unique advantages that Netscape 7.0 offers over prior Netscape browsers and competitive
products. Throughout this guide, we use icons to visually indicate these advantages; when Netscape 7.0 has a
clear advantage compared to other products, or has a new feature since Netscape 6.2, you will see these icons:

♦   A reason for Netscape 4.x and 6.x users to upgrade

♦   An example where Netscape 7.0 has a unique advantage over other browsers

♦   New since the release of Netscape 6.2
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Have you ever opened several browser windows on your desktop and gotten lost in the clutter? Or
interrupted what you were doing on your computer to check and see if new mail had arrived?
Netscape 7.0 lets you use the Web more efficiently. Netscape Navigator simplifies and streamlines
the most common online activities, and Netscape Mail is a powerful and complete tool to manage
e-mail the way you want.

Here are some of the features in Navigator and Mail that save you time and fit the way you use the
Web:

♦  BROWSING

� Quick Launch speeds start-up time for the browser. Now, get online with Netscape 7.0 faster
than ever before.  

� Tabbed Browsing lets you keep track of multiple sites or pages at once by letting you view
them within a single browser window. You can easily click between pages using a tabbed
interface. Tabs load in the background so you can browse the Web faster—and stay
organized.   

� Open your favorite news, entertainment or finance sites within Tabbed Browsing then file them
as a Groupmark—a timesaving way to later visit a set of pages or load your favorite sites each
day.   

� More easily keep track of where you are on the Web with Web Site Icons—small icons that
Web site authors use to brand their pages. These icons are shown in the URL field and are
also handy within Tabbed Browsing.  

� To maximize screen space, Full Screen Mode lets you see more of a Web page when you
need to. This is great for viewing web content on laptops or smaller desktop screens. 

♦  DOWNLOADING AND SAVING FILES

� Download multiple files at once and reliably pause and resume a download if your Internet
connection is interrupted or you need to use your connection to make a phone call.

  



CONFIDENTIAL UNTIL THE PUBLIC

AVAILABILITY OF NETSCAPE 7.0 08/21/02

� The new Download Manager keeps track of all your downloads from one place. View
information on the status of your download, percentage complete, download location, source,
time remaining and more.   

� What used to take several steps to download and save a complete Web page, now takes only
one. In a single action, save a page with all of its graphics files (GIFs and JPEGs). No need to
individually download each file to capture all the content on the page.  

♦  SEARCH

� The Click-to-Search feature lets you easily search on any
word you highlight in a Web page without having to leave the
page. The results appear in a separate window and in the
Search tab in My Sidebar.   

� Less scrolling and fewer back button clicks
mean faster searches. My Sidebar Search
Tooltips let you see more detailed
information about search results within the
Search Sidebar Tab.        

♦  PRINTING

� What you see is what you print with new Print Preview and Page Set-up tools. You have more
control over the output, sizing, margins, scale, and even headers and footers.  

♦  MAIL

� Netscape’s fastest e-mail product ever—faster scrolling; quickly open message windows to
compose reply and forward messages.   

� Find an e-mail address or message within your e-mail inbox  lightning-fast. Type only a few
letters in the Quick Search field, and matching results come up based on the subject line or
sender—instantly.   
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� Like Quick Search in Mail, Quick Search in Address Book locates a name instantly without
needless scrolling.   

� Mail alerts give discreet notification of new mail messages in your computer’s system tray—
even if you don’t have Netscape 7.0 open on your desktop1.   

� Organize your inbox or folders with color-coded Mail Labels that correspond to a category that
you set, such as “ASAP,” “To Do,” “Personal,” or a project name. You can then sort by Label to
help you prioritize or find a message.   

� Simplified Mail Filters offer an easy and personalized way to organize e-mail or quickly send
spam messages to the trash.   

� Get directions fast from your Address Book in one click. The Get Map button from within an
address card serves up immediate results from MapQuest®.   

� Importing e-mail from other programs is easy. Netscape 7.0 offers all-in-one import of e-mail
messages, account settings and address books from other mail programs such as Netscape
Communicator, Eudora, Outlook and Outlook Express. 

♦  EASE OF USE

� Update Notifications in Netscape 7.0 let you know when a new release of the browser is
available.  

� Redesigned top-level browsing menus are
now more intuitive. The Tools menu now
includes timesaving features such as Cookie
Manager, Password Manager, Download
Manager, Form Manager, and Search the
Web.  

� My Sidebar is easier than ever to close and reopen. To close click the “X” at the top right of My
Sidebar.  To reopen, click the sidebar open/close icon on your personal toolbar, or go to the
View Menu (Show/Hide->My Sidebar).     

                                                          
1 Mail alerts are supported in the Windows version of Netscape 7.0.
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The growth in instant messaging has exploded over the past few years, with AIM leading the way
as the world’s most popular instant messaging service. Its extensive use among friends and
family—and increasingly in business—has made it an indispensable communications tool. AIM
within Netscape 7.0 now includes several new features that make it more convenient and
customizable.

� Start instant messaging immediately after you turn on your computer and connect to the
Internet. By choosing “Sign on at Launch,” the built-in version of AIM starts up in a slim, stand-
alone window even before you launch the browser.   

� Express your personality or mood with Buddy Icons—a
fun and simple way to personalize instant messages.
Choose from hundreds of available icons, including
favorite cartoon characters and other animated images.
You can also create your own and import it into AIM.
Buddy Icons are easy to install so you can change them
on a whim.   

� AIM is integrated in all the components of Netscape 7.0—whether you are in Navigator, Mail or
Composer—so you have constant and immediate access to your online buddies.  

� Set AIM to alert you when specific buddies come online or go offline. You can choose a sound
alert or a Buddy Alert window.  

� Need to get a file to someone fast? AIM now lets you directly transfer files from PC to PC to
people on your Buddy List.  

� Your AIM Buddy List is saved on a server, which means you can access your Buddy List from
any computer where AIM is installed. 

� The AIM Today window launches automatically when you start AIM and allows you to stay in
touch with the AIM community, check out the latest news and newly available Buddy Icons.
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♦  RADIO@NETSCAPE

� The new Radio@Netscape, built right into the Netscape 7.0 personal toolbar, brings you
access to great music in just one click. An easy-to-use player offers leading music choices with
over 175 stations to choose from. Customize Radio@Netscape pre-set channels by selecting
from a wide variety of music genres, or you can listen to the choices of a guest DJ.  

.

♦  WEB PUBLISHING

� One-Button Publishing lets you easily save web documents created in Composer to a server
of your choice in just a few clicks.    
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Faster Performance Enhanced performance to speed you through the most important online
tasks; Netscape 7.0 is the fastest Netscape browser and faster than
competing browsers on some platforms.

Quick Launch Start-up in Netscape 7.0 gets you online faster than ever before.

Tabbed Browsing Efficient, more organized browsing of multiple pages within a single
browser window.

Click-to-Search Initiate a search based on any word in a Web page. Search results
show in a new browser window and in My Sidebar.

Search Tooltips Choose the right results faster by mousing over search results in the
Sidebar Search Tab to reveal more detailed information.

Web Page Save Easy one-step process for saving a Web page and all its associated
graphic files.

Full Screen Mode View more Web page content on your screen.

Printing Improved Print Preview and more control over printing.

Radio@Netscape One click from the personal toolbar to music and station lists that you
can customize.

Faster Access to
Powerful Tools

Better organized, top-level Navigator menus provide fast access to the
new Download Manager, as well as Password Manager, Form
Manager and Cookie Manager.

Download Manager Download multiple files at once, pause and resume, and manage all
your downloads from one place.

Mail Organization
Tools

Simple filter set-up for wanted and unwanted e-mail; Quick Search to
find a message or an address fast; Labels to color-code and prioritize
messages, return receipts.

New Mail Alerts Know when new e-mail arrives—even if you aren’t using the browser.

Get Map Address Book gives you a direct link to MapQuest directions.

AIM Enhancements Buddy Icons, transfer files PC-to-PC, Buddy Alerts, AIM Today, access
to ICQ service.

Corporate Mail
Features

Secure Mail (S/MIME), shared folders for IMAP users, secure LDAP,
offline LDAP.

Update Notification Automatic notification when new versions of the Netscape browser are
available.

Web Page Publishing One-button publishing functionality in the Composer Web page editor.
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Quick Launch Start-up in Netscape 7.0 gets you online faster than ever before.

Click-to-Search Quickly search on any word on a Web page, even if it’s not a hypertext
link.

Quick Search Find messages in your inbox or names in your address book with
lightning speed and less scrolling.

Tabbed Browsing Efficient, more organized browsing of multiple pages within a single
browser window.

Simple Filter Set-up Just a few steps to set up filters that organize wanted e-mail or eliminate
unwanted e-mail.

Custom Labels Use color-coded, custom labels to help organize and prioritize messages
in your inbox.

Groupmarks Save a set of Navigator tabs to launch in one click.
Get Map One click to directions from MapQuest right from your Address Book.
AOL Instant
Messenger

Built-in AIM, the #1 instant messaging service.

Buddy Icons Fun and customizable graphics to personalize your messages and online
identity.

Download Manager Pause and resume, download multiple files at once, more easily manage
file downloads.

Sidebar Search
Tooltips

More detailed search results in My Sidebar help you quickly narrow your
search.
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Smooth migration (bookmarks, e-mail, and more) and quick download make it easy to upgrade.

Tabbed Browsing for faster and more organized Web surfing within a single browser window.

Fully integrated AIM, the #1 instant messaging service, now with Buddy Icons, file transfer and
Buddy Alerts.
Better and faster mail—Quick Search in Mail and Address Book, Custom Labels, Simple Filter
Set-up, presence of AIM buddies.
Powerful Search capability with My Sidebar Search Tooltips and Click-to-Search on a word within
a Web page.

Full Screen Mode in Navigator is handy for laptop users.

Gecko power – A Web experience for the modern Web with rich and dynamic content displayed
as Web site authors intended.
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Netscape Gecko is the embeddable cross-platform browser engine at the heart of
Netscape 7.0.  Netscape Gecko controls how a Web page appears on the screen and
provides content rendering and support for Web standards such as HTML, XML,
Cascading Style Sheets (CSS), the Document Object Model (DOM), and JavaScript. To
ease the creation of desktop applications and devices that embed Netscape Gecko, it also
features a cross-platform, cross-device architecture and powerful technologies such as the
XML-based User interface Language (XUL).
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Netscape realizes it is expensive to develop and maintain separate code for Web pages
on different browsers. Developers are also keenly aware that pages coded using non-
standard, proprietary techniques often do not display as intended.  That’s why Netscape
DevEdge (http://developer.netscape.com) delivers tools, documentation and a knowledge
base through a powerful community for building Web content that works in both Netscape
and Microsoft browsers, CompuServe 7.0 as well as other browsers that embed Netscape
Gecko.

For a more complete list of features, product descriptions and standards support, see the
Netscape 7.0 Reviewer’s Guide.
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Setup Type Total Size
Custom
Options from ‘Navigator Only’ to ‘Full’

9.3 MB  to
31.9 MB

Recommended*
Navigator, Mail & Newsgroups, Instant Messenger, ICQ, Quality
Feedback Agent, Spell Checker, Viewpoint Media Player, Macromedia
Flash Player, HP Printer Identifier Plug-in, Classic Skin, AOL Art
Extensions
* Includes additional options for Sun Java 2, Real Player 8, and WinAmp

14.8 MB

Full
Navigator, Mail & Newsgroups, Instant Messenger, ICQ, Sun Java 2,
Quality Feedback Agent, Spell Checker, Net2Phone, Real Player 8,
WinAmp, Viewpoint Media Player, Macromedia Flash Player, HP
Printer Identifier Plug-in, Classic Skin, AOL Art Extensions

31.9 MB
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           Netscape 7.0 Requirements
      

     Windows Operating
Systems

Windows 98, 98SE,
Windows ME,
Windows NT 4.0,
Windows 2000,
Windows XP

     Minimum
Hardware

233 MHz
64 MB RAM
26 MB hard drive space for minimum install

     Mac Operating
Systems

Mac OS 8.6 or later, Mac OS 9, Mac OS X

 Minimum
Hardware

PowerPC 604e 266 MHz or faster processor, G3, or
G4
64 MB RAM
36 MB hard drive space 

     Unix Operating
Systems

Linux kernel-2.2.14 or greater, with the following
libraries or package minimums:  

•  glibc - 2.1.0
•  gtk+ - 1.2.0 (1.2.5 or greater preferred)
•  XFree86-3.3.6

Supported Platforms:
Netscape has been certified and is supported on
RedHat Linux 6.2, 7.0, 7.1, 7.2 and greater.

 Minimum
Hardware

233 MHz
64 MB RAM
26 MB hard drive space
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Get the most from your time online: Netscape 7.0 fits the way you use

the Web
For more and more people, the Internet has become part of our everyday lives. We increasingly rely
on the Web to communicate, get informed, shop, or simply be entertained. But while a growing
number of us value the Web, we also value our time and want to get more from the time we spend
online. Netscape 7.0 is designed so you can be more efficient with the key things you do online.
Powerful features plus options to customize your experience give you a browser that fits the way
you use the Web.
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Netscape 7.0 sports the fine-tuned, standards-based Netscape Gecko browser engine that speeds
up page loading, browser and e-mail activities. New features in Netscape 7.0 make you more
efficient where it matters most. With Quick Launch, you get online faster than ever before. Netscape
7.0 also allows you to quickly view multiple Web pages from a single window, easily print pages,
search, and conveniently download several files at once. You can also rely on Mail in Netscape 7.0
to manage all of your Internet communications. Locate an e-mail message or address quickly, set
up filters for wanted or unwanted mail, customize incoming messages with special labels—even get
MapQuest® directions with a single click from your address book.
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Integrated AOL® Instant MessengerTM (AIM®) lets you stay in touch with family, friends, and
colleagues using the world’s most popular instant messaging service. Improvements to AIM in
Netscape 7.0 let you to access your Buddy List faster, receive an alert when a buddy comes online,
quickly transfer files, and personalize messages with fun graphics.

#�����
�$����
�

The Internet isn’t all about efficiency, it’s also a leading source of entertainment for an increasing
number of users. Netscape 7.0 offers the new Radio@Netscape built right into the browser. One
click brings you to over 175 stations so you can easily choose the type of music you like to listen to –
from alternative to classical to R & B and more.
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Efficient Web browsing

With Netscape Navigator, browse the Web more efficiently than ever before and eliminate many of
the steps involved in some of the most commonly performed tasks. New innovative features such as
Tabbed Browsing, integrated Radio@Netscape as well as improvements in printing, search, and
downloading dramatically streamline the activities you do online. These features, combined with
overall enhancements in performance and stability, make Netscape Navigator the clear choice for
being more productive on the Web.

;
�������
����-�����������������
���'������1����
��

Tabbed Browsing allows you to view multiple Web sites or pages much faster and in an organized
way. 2 It eliminates waiting for a page to load in a separate browser window —while viewing one
Web page, load another page in a separate tab. Allow the second page to load in the background
while you view content in the first. If you are browsing multiple tabs, easily switch between them by
clicking the top of the tab which allows you to easily keep track of pages instead of clicking on
numerous browser windows on your desktop. If the site you are visiting supports Web Site Icons
(small graphic icons that developers include in their HTML code), you will see the icon appear at the
top of the opened tab, a handy feature for keeping tabs organized and easily identifying them.

                                                          
2 Tabbed Browsing can be accessed in one of four ways: by clicking the “Open a New Tab” button to the
left of the tab bar, from the File menu, choose “New” and then “Navigator Tab”; or you can right-mouse
click a hypertext link and open its contents in a new tab; or for those who prefer keystrokes, “Ctrl T” opens
a new tab.

Chapter

"
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While researching a new car you might want to compare information on several sites. Use Tabbed Browsing
to view Blue Book pricing in one tab while you view the manufacturer’s Web site in a second tab for car
details. In a third tab, you might choose to search for the car on an auction site. Because you are interested
in what other drivers who own the car have to say, you open a discussion group session in a fourth tab.
Switching between these tabs is easy and faster than switching between open browser windows.
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Do you have a favorite list of sites you visit every day? Netscape Navigator allows you to open them
all in separate tabs in just one click from your bookmarks, by using the Groupmarks feature from the
Bookmark Manager. You can set up a Groupmark by opening up the Web sites in separate tabs
and saving them as a group by going to the “Bookmark this Group of Tabs” item in the Bookmark
Menu.  You'll save precious time by loading your selected sites in tabs all at once and clicking
between tabs to view them.
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Netscape 7.0 brings you convenient one-click access to the leading radio content on the Web with
greater variety to satisfy a wide range of music tastes. Integrated in the Netscape 7.0 personal
toolbar, the new Radio@Netscape is a fun, easy-to-use player that allows you to choose from
dozens of music genres and over 175 stations. You can choose from Awesome80s, Alternative
Rock, Top Classical, All Jazz, Hip-Hop and stations programmed with your favorite artists, and
much more.

Radio@Netscape uses the RealPlayer installed on your machine to deliver music playback3. Once
launched, you select a station and begin listening to Radio@Netscape. Save up to seven of your
favorite stations by clicking the “Add” button.  Song information is always displayed to provide the
name of the station, artist, song and album that is currently playing. You also have the ability to rate
the song or purchase the album that is currently playing.  Just click the Radio button in the personal
toolbar to begin your listening experience.

                                                          
3 RealPlayer 8 is available with all installation configurations of Netscape 7.0.
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Accessing your e-mail, sending instant messages, browsing, and using My Sidebar have never
been simpler.

Now when you launch Netscape Navigator 7.0 you will be able to access Mail and AOL Instant
Messenger (AIM) directly from your personal toolbar for instant communication.  In addition, the top-
level browsing menus in Netscape 7.0 have been reorganized to be more intuitive and easier to use.
A new top-level Window menu allows you to access all key browser features from one place—
Navigator for browsing, Mail & Newsgroups, Address Book, and AIM for instant communication with
your friends and colleagues.

My Sidebar is easier than ever to close and reopen.  Simply click the “X” at the top right of My
Sidebar to close.  To reopen, click the sidebar open/close icon on your personal toolbar or go to the
View Menu (Show/Hide -> My Sidebar) or use F9 keystroke to open and close.
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Building on the advances in search pioneered in Netscape 6.0, Netscape 7.0 sets the standard for
quickly finding what you want on the Web.
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While reading a Web page, you can easily search on a
specific word, even if the Web page author has not
provided a search link for the text. The new Click-to-
Search feature lets you highlight any text and initiate a
search on the Web by simply clicking your selection.
Search results are brought up in a new window so you
won’t need to navigate back to the page where your
search originated.  Click-to-Search accesses the search
engine you have set as the default for Netscape Navigator
7.0.
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Netscape 7.0 improves on My Sidebar Search Tab introduced in Netscape 6.0.  New tooltips make
it easier than ever to navigate to your search results from My Sidebar.  There's no need to browse
back to your search results page to view more detail. Simply mouse over the displayed search
results in the search tab and the title of the Web page will appear.
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Next to searching for information, downloading files is one of the most frequent things we do on the
Web. With Netscape 7.0 you have greater convenience and control over this common task. It’s
easier to download multiple files at the same time and keep track of where you download them.
With the new Download Manager, you can view all your downloads from one screen and see which
directory on your computer you saved the downloaded file to and where you originally downloaded it
from.4 You can also launch a file immediately after the download is complete by selecting Launch
File.
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Have you ever needed to use the phone in the middle of a download? Netscape 7.0 helps you
recover your download from where you left off if your Internet connection is dropped, without
requiring you to start the download from the beginning.  With Netscape 7.0, you can pause your
download and then resume after you have finished your call, a useful feature for users at home.  If
your connection is dropped, Netscape 7.0 automatically pauses your download for you.  Once you
restore your connection, you can pick up  where you left off by clicking the “Resume” button.

                                                          
4 You can access the Download Manager from the Tools Menu of Netscape 7.0 menu.
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Netscape 7.0 now displays Web Site Icons, small images that Web site authors include with their
Web pages. These Web Site Icons show up in the browser URL bar and in tab titles in Tabbed
Browsing to create a more customized appearance that easily identifies the look and feel of the Web
site you are viewing.
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Access your Buddy List from various areas within Netscape Navigator 7.0.  Select AIM from the
Window menu or click one of the AIM icons located in the personal toolbar or in the lower left corner
of the Navigator window.  You can also have your Buddy List available in any Netscape 7.0
component as a tab in My Sidebar.
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Have you ever tried to save a Web page but found that you only saved the HTML or text portion of
the page, without any of the graphics or images? Now Netscape 7.0 saves you time by offering a
more efficient way to save a Web page plus all graphics (GIFs or JPEGs) within one folder. When
saving a page, you can use the pull-down menu in the dialog box and choose to save as “Web
Page, Complete”, “Web Page, HTML only” or “Text”.  By choosing “Web Page Complete”, you will
create a directory at your save location with all of the HTML, images and other graphics for you to
access later.
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When you want more screen real estate to view a Web page, Full-Screen mode lets you see more
of the Web with fewer menus and browser controls.5 For laptop users, this feature is especially
useful, allowing more screen real estate for viewing content-heavy pages.
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Bookmarks--everyone’s favorite browser customization tool—is now more useful than ever in
helping you keep track of your top Web destinations.  Netscape 7.0 helps you organize your
bookmarks quickly and efficiently by allowing you to drag and drop Web sites into specific folders or
locations in your bookmarks.  You can drop them into locations on your personal toolbar or, if you
prefer, use the Bookmarks tab in My Sidebar.

                                                          
5 To use Full Screen mode, simply select Full Screen from the View menu.  To view the browser toolbar
again, move the cursor to the top right of the browser and click the restore box, or use a keystroke (F11) to
toggle back and forth.
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Netscape 7.0 offers new printing features and gives you more control so printed pages look more
like what you see on the Web. “Print Preview” and “Page Setup” options from the File menu allow
you to view exactly how the page will be printed, plus adjust the orientation to landscape or portrait
format.  You can also shrink the Web page to fit it on a printed page, set scale and edit margins,
headers and footers.
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Privacy is of increasing importance on the Web.  The Platform for Privacy Preferences Project
(P3P), developed by the World Wide Web Consortium (W3C), is a new standard designed to help
users understand and gain more control over the use of personal information on Web sites they
visit. Netscape 7.0 introduces two new privacy-related features based on the P3P standard.
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When you visit a Web site, you often want to know the privacy practices it follows, especially if you
are conducting online transactions or sharing personal information.  In the past, sites published
privacy policies in a variety of locations that were sometimes difficult to find.  The new Privacy Policy
Viewer lets you easily locate and view the privacy policies of P3P-compliant sites.
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Some sites include a P3P compact policy with each cookie they send to your system.  This
information tells you about how the site uses the information stored in the cookie. The new
Netscape 7.0 P3P Cookie Management feature notifies you when a site sends cookies with certain
privacy policies, and gives you easy access to the powerful Netscape Cookie Manager to edit your
preferences.  If you want even more control, you can set up a custom privacy configuration to
handle each class of cookie—you can accept, set limits to the current browser session, or reject
cookies based on the privacy policy and source of each cookie.
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Netscape makes periodic enhancements to its browser suite to ensure leading quality and security.
The new Update Notification feature in Netscape 7.0 keeps you informed of the latest updates.  You
can even customize it to check for updates as frequently or infrequently as you would like.
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Enhanced Mail and the #1 Instant Messenger at your fingertips

In just a few short years, the Web has revolutionized how we
communicate with people – whether it is with friends, family,
colleagues or even customer service agents. Trading an e-mail
address or instant messaging Screen Name has become as
common as exchanging a telephone number.  These pieces of
information have grown to become part of our online identity.These
forms of communication are truly part of our daily lives. E-mail is the
most common online activity of Internet users6, and AOL Instant
Messenger (AIM), the world’s most popular instant messaging
product, has swelled to over 140 million users.

In Netscape 7.0, Internet messaging tools have been integrated to make communication effortless.
Sending e-mail or instant messages is now easier than ever. New enhancements in Netscape 7.0
Mail and Address Book make it faster and more convenient to manage large volumes of mail.
Integrated AIM in Netscape Mail and Navigator is also improved with more features to instantly
communicate and personalize your messages. In addition, AIM is now available as a standalone
component of Netscape 7.0 that can be launched automatically when you turn on your computer. 7

                                                          
6 UCLA Center for Communication Policy – Nov 2001
7 When first signing on to AIM within Netscape 7.0 choose the “Sign-on at Launch” option.
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Netscape Mail
Netscape Mail lets you conveniently manage all of your Internet communications from one place.
With support for multiple accounts—including your work or ISP e-mail account, AOL mail and
Netscape Webmail accounts—you can easily keep track of your multiple business and personal e-
mail accounts and Internet newsgroups, all from one place.  Integrated AIM lets you see when
friends and colleagues are online and instantly communicate with them.  Improved performance and
speed within Netscape Mail, combined with great convenience features, means you can rely on
Netscape 7.0 for all your Internet communications.
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Waiting for an important e-mail message, but don’t want to keep opening up your e-mail inbox or
switching to your e-mail display?  Netscape 7.0 Mail allows you to continue working and still be able
to monitor your inbox without interruption. A sliding alert dialog, appearing above your system tray in
the lower right corner of the computer screen, notifies you that new messages have been received.
The alert slowly slides open, pauses, and then slowly slides closed without taking you away from
your current task. Click the notification, and go straight to your new messages.

Whether or not you have Netscape 7.0 open, the New Mail Notification feature8 can quickly take you
straight to your new messages for any of your multiple e-mail accounts, or simply let you know that
you have e-mail waiting.

                                                          
8 Available in Windows version of Netscape 7.0.
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Now finding messages in your inbox is easy.  With Quick Search, simply type a few letters of a
sender’s name or a word from the subject line in the Quick Search field, and you will see the
matching results instantly appear.  The more letters you type, the more refined your search will be.
Deleting the letters or clicking the 'Clear' button will restore your view of all your messages to their
original order.

Need to find a message with more search power? Click 'Advanced' for a more full-featured search
experience. Using the Advanced feature you can search multiple folders, using multiple search
criteria, all from the same window.  You can also find messages quickly by sorting your e-mail by
date, subject, sender, or status—virtually any attribute of your mail message.

Are you in a hurry, looking for a phone number a friend e-mailed to you last week? With just a couple of
keystrokes, searching through your email is a snap.  No need to become frustrated trying to dig around your
inbox—use Quick Search for fast and easy message retrieval.
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We receive more and more e-mails each day, we are continually looking for ways to organize and
prioritize.  The Custom Labels feature is a new tool that lets you color code your e-mail and assign
named categories to help you group, organize and prioritize your messages, making you more
efficient.

You choose the name and/or color of each label.  For example, set up red labels for urgent e-mail,
blue for personal, green for “To Do’s,” etc. If you then want to view all of your “To Do” e-mail, you
can simply sort by Label. You can also set up filters in which your e-mail is marked with a particular
label.
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E-mail filters allow you to sort incoming e-mail into folders, turning your inbox into an organization
and productivity tool for you to manage communications.  If you haven’t used filters before,
Netscape 7.0 can help you quickly set them up. Just right click the name of any recipient or sender
from within the e-mail to start creating a filter. In a few easy steps you can set up the filter in
Netscape 7.0. To edit existing filters or create new ones, from the Tools menu choose Message
Filters. Filters can be particularly useful if you commonly receive unwanted messages from the
same sender. Simply set up a filter that sends these messages to the Trash folder.
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For certain e-mails it’s necessary to know when the intended recipient has opened the message.
With MDN9 Return Receipts, you’ll get an e-mail telling you the date and time your message was
opened by its recipient.  Once you set up the Return Receipts feature, you can receive notification
on all outbound messages or you may set up notification for specific recipients.  As an e-mail
recipient, you may also accept or deny a Return Receipt request from the sender.

                                                          
9 MDN = Message Disposition Notification
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Netscape 7.0 provides convenient and consolidated e-mail import tools enabling you to upgrade or
switch to Netscape 7.0 easily and quickly.  Accessible from either Netscape Mail or Address Book,
you can import all of your mail messages, e-mail settings, and address book entries from other e-
mail applications into Netscape 7.0.

The Import Wizard for Address Book supports Netscape Communicator, Eudora, Outlook, Outlook
Express, or text files (LDIF, .tab, .csv, .txt); The Import Wizard for Mail & Settings supports Netscape
Communicator, Eudora, Outlook, & Outlook Express.
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Avoid scrolling through your long list of addresses. Just like using Quick Search in Mail &
Newsgroups, you can now type a few letters and find the corresponding name or e-mail address of
the person you are looking for in your address books.  You can use Quick Search in all of the
address books that Netscape 7.0 supports, including personal or work, collected addresses or
directory servers.
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Do you need to transfer your address book to another computer or application, such as a wireless
device?  The Address Book Export feature in Netscape 7.0 supports several formats including
comma delimited (.csv), tab delimited (.tab, .txt), or Netscape’s address book format (.ldi, .ldif).  If
you need a hard copy you can also print out your entire Address Book.
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MapQuest is a world leader in online mapping and driving directions.  Now one click from a card in
your Address Book will bring you to directions from MapQuest. This convenient new feature saves
you time and allows you to quickly map addresses you have saved in your address book.
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Setting up and accessing a Netscape Webmail account from within the Netscape Mail is easier than
ever with Netscape 7.0.  You can also use Netscape 7.0 Mail to access your Netscape Network Mail
account.
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Just click the “Sign Up” or “Set up your account” link and you are immediately taken to account set
up where all the work is done for you. Once you have set up your Netscape Webmail account, you
can also synchronize your Netscape 7.0 Address Book so your addresses are easily accessible,
even when you are away from your computer.
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Netscape 7.0 now lets you send and receive S/MIME encrypted and/or signed e-mail messages.
Signing and encrypting messages can be done with a single mouse-click.  When you encrypt your
e-mail messages, you’ll know that your private e-mails are safe from being read by anyone other
than the intended recipient, even if the message is intercepted on the way.
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Netscape 7.0 gives you the ability to make mail folders accessible to more than one person within
your IMAP environment. You can delegate access to IMAP mail folders through simple preference
settings. For example, an executive can delegate inbox access to an assistant. By creating shared
folders and providing access to team members, groups can share information and enhance
collaboration while limiting the drain on system resources.
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Netscape 7.0 lets you connect to an LDAP server securely using SSL (Secure Sockets Layer).
Secure LDAP protects the information being passed from a directory to the Netscape 7.0 Mail
application.  This feature is especially useful for corporate users who need to safely access their
company's directory while away from the office.
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Netscape 7.0 lets you perform LDAP replication (full copy) as well as synchronization (changes
only) to your Address Book. Offline LDAP allows you to access the corporate directory for mail
composition or contact information look-up while disconnected from the corporate network.
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Netscape 7.0 offers increased flexibility to customize how you receive and display your    e-mail.
These new options help you keep personal information safe and your computer secure without
compromising the rich and robust experience common on the Web today.  Netscape 7.0 Mail &
Newsgroups includes the ability to enable and disable cookies, JavaScript, remote images (images
on a server), and plug-ins (including Java), in order to tailor your experience to your own needs and
preferences.
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Instant Messaging with AOL Instant Messenger (AIM)
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Netscape 7.0 now allows you to get started with instant messaging faster than ever.   Whether you
have a Screen Name already or need to register for a new one, you’ll find the process easy, intuitive
and fast.

In addition, AIM can start up and log you in automatically if you have chosen “Sign-on at launch” on
the sign on screen so when you turn on your computer you’re ready to talk to online buddies right
away.
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Netscape 7.0 now includes support for Buddy Icons which are fun, personalized images you can
associate with your Screen Name and have your buddies see every time you IM them.  You can
select from dozens of categories such as Movies & TV, Music, and Sports as well as specific titles
you know and love like ET the Extra-Terrestrial.

Not only that, but you can now create your own Buddy Icon to personalize your online experience
even more.10  You can preview the icon so you can see for yourself how your icon will look to your
friends.

Netscape 7.0 also allows you to easily personalize your messaging experience by enabling you to
choose custom colors and styles for the text you send to your buddies.

                                                          
10 Simply open AIM from the Window menu, personal toolbar button, or taskbar button.  Choose “Select
Buddy Icon” from the People menu and choose your own Buddy Icon.
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Instant messaging isn’t just for chatting anymore.  With the new file transfer feature, you can easily
send files to your buddy from your computer.  For example, send a presentation you’re working on
to a co-worker or a picture of the kids to your parents.

Sending a file to a buddy is simple.11  Your buddy will have the option to accept or deny receiving
the file.

1���������������������$��������$�������G�����
��

With new Buddy Alerts in Netscape 7.0, you can receive an alert when a buddy comes online.  To
set up an alert for a favorite buddy, just select the buddy, right click, and choose “Alert me when
[selected buddy] is available.”

              

Do you need to let people know when you are away from your desk or just too busy to reply? By clicking the
Away button, you can create a custom message such as “Picking up Kids” or change your online status to
"Unavailable," "On the Phone," "Out to Lunch" or "Meeting”.

                                                          
11 To transfer a file, choose a buddy from your Buddy List, select People, then click send file to Buddy.
Select File to locate the file on your computer, then hit send.
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When reading a message in Netscape 7.0 Mail, an instant messaging icon in the header of the
message indicates whether the sender and other recipients are on AIM (see below). Simply click the
icon to add the sender to your Buddy List, or begin sending and receiving instant messages.   By
moving the communication from e-mail to instant messaging, you can solve issues in seconds that
might otherwise have required more time and multiple emails.
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Are you out of town, without your computer, but still want to contact friends and colleagues? AIM
stores your Buddy List on servers, which means you can now access your Buddy List from any
computer or wireless device using AIM, without retyping any of your buddies’ Screen Names.
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The AIM Today window allows you to stay in touch with the AOL Instant Messenger community—
grab the latest buddy icons, rate-a-buddy, or check out the latest news and sports scores.
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ICQ, a global communications community and international service from AOL with over 120 million
registered users, is now integrated with Netscape 7.0.  This convenient integration allows you to

choose to log on to either AOL Instant Messenger or
ICQ depending on your preference.  It’s easy to
switch between AIM and ICQ by using the drop down
menu to select which service you’d like to sign on to.12

Log in to ICQ and enjoy chatting with your ICQ
friends, or use the powerful communication and
search tools to find new ICQ friends with similar
interests around the world.

                                                          
12 To select ICQ open the instant messenger component in the Sidebar or as a stand-alone window.  From
the service sign on drop down menu, select ICQ.
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Create and publish your own Web documents

The Web has opened up an entirely new publishing environment, allowing professional and novice
Web users to get their ideas out to a broad audience.  Netscape Composer is an efficient way to
create, edit and publish documents to the Web.   You can use pictures, tables, graphics and links to
create a variety of documents like detailed reports, resumes, travel journals or family photo albums.
With the new publishing features in Netscape 7.0, anyone can become a Web designer.
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Netscape Composer enables you to post documents easily to the Web with the One-Button
Publishing feature in Netscape 7.0. One-Button Publishing allows you to take your favorite Web
documents and publish them to any server or Web location where you have an established account
(e.g. your personal
URL on the Web).

To use One-Button
publishing, simply
specify the site to
which you’d like to
publish, create the
destination names
(directories), and
you're all set.

Netscape Composer
remembers the
directories that you
set up, and allows for
easy switching
between multiple
publishing
destinations.
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Have you recently returned from a fantastic vacation, and want to share your experience with others? Take
your digital pictures, download them onto the PC, post them to your Web site, and then send e-mail to
friends and family with the link. With the Composer application in Netscape 7.0, you have the tools to build a
Web page, without having to take a course in HTML or Web authoring, or hiring someone to do the job.       
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Download and install only the components you want

The Netscape 7.0 experience begins with a quick, customizable, and easy installation process. The
size of our software continues to be small for faster downloads. You can pause and resume the
download of Netscape 7.0, and recover your download if you lose your Internet connection. We’ve
also set up the installer so that only the portions of the product you choose to install are actually
downloaded – you never download software you don’t need.  And finally, we’ve built installation
capabilities right into Netscape 7.0, enabling users to automatically install updates directly from the
Web.
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Customers who download Netscape 7.0 will appreciate the fast and intuitive download and
installation process.

Chapter

3



+<
CONFIDENTIAL UNTIL THE PUBLIC AVAILABILITY OF
NETSCAPE 7.0

)�����
��������

Netscape 7.0 has an installer that is under 250 KB in size. It downloads quickly and provides
immediate access to your installation choices. Netscape 7.0 also reduces the number of choices
you must make before installation begins.

All of the required input in the installation process takes place up front. Once you make the choices
presented to you in the installer, everything proceeds automatically. You are then up and running
with Netscape 7.0.
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Because the Netscape 7.0 installer presents you with installation choices up front, you will never
download software you didn’t choose. In the past, users downloaded an installer package that
contained all the possible software choices. Only after the package was on their desktop would the
user be given the choice of what options they wanted. With Netscape 7.0, you choose up front and
get only what you need, saving you          download time and hard drive space.
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Setup Type Total Size
Custom
Options from ‘Navigator Only’ to ‘Full’

9.3 MB  to
31.9 MB

Recommended*
Navigator, Mail & Newsgroups, Instant Messenger, ICQ, Quality
Feedback Agent, Spell Checker, Viewpoint Media Player, Macromedia
Flash Player, HP Printer Identifier Plug-in, Classic Skin, AOL Art
Extensions
* Includes additional options for Sun Java 2, Real Player 8, and WinAmp

14.8 MB

Full
Navigator, Mail & Newsgroups, Instant Messenger, ICQ, Sun Java 2,
Quality Feedback Agent, Spell Checker, Net2Phone, Real Player 8,
WinAmp, Viewpoint Media Player, Macromedia Flash Player, HP
Printer Identifier Plug-in, Classic Skin, AOL Art Extensions

31.9 MB
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Get even more out of the Internet with industry leading additions
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Netscape 7.0 offers cutting-edge
add-on applications that help you
get more from the Internet.
Offered with Netscape 7.0 are
Java for running Web applets,
Nullsoft Winamp for audio
playback, RealPlayer8 for
streaming media, Macromedia
Flash for high impact Web
content, Net2Phone for making
inexpensive calls from your PC
and Viewpoint to maximize
visuals in low bandwidth
environments.
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The Java plug-in from Sun Microsystems allows you to run applets on the Web, making your
Internet experience richer and more powerful. Java is included automatically in the Full configuration
of Netscape 7.0, and you can choose to install it in Recommended and Custom configurations as
well.
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The Java plug-in is available for Windows and Linux, and features complete Java 2 support. On
MacOS, Netscape 7.0 integrates with Apple’s MRJ (MacOS Runtime Java).
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The original audio player, Winamp plays all
kinds of audio files, including your MP3s. Play
CDs, organize your music and create play
lists.

Winamp is available for Windows, is included
in the Full installation and is optional in both
Custom & Recommended installations of
Netscape 7.0.
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With RealPlayer 8, the leader in streaming media, you can experience the broadest range of audio
and video (A/V) content on the Web. New features make it easier than ever to quickly find the
programming you want and deliver the highest-quality A/V.

RealPlayer 8 is available for Windows and Mac OS versions 8.6 and 9.x.  It is included in Full
installations of Netscape 7.0, and is optional in Recommended and Custom packages.
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Macromedia Flash Player is a browser plug-in that gives you a more engaging experience on the
many Web sites that use Flash technology. Flash enables interactive content, even over low-
bandwidth connections, with integrated vector and bitmap graphics, motion and MP3 audio.

Every configuration of Netscape 7.0 contains a small Flash program that helps you easily install the
full Flash plug-in the first time you need it.  The latest version of Macromedia Flash Player, Flash 6,
is available for Windows and MacOS, while Flash 5 is available for Linux.
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Net2Phone, by Net2Phone, Incorporated, allows you to use your computer to inexpensively place
domestic and international calls to any telephone in the world. Using this application, you can save
up to 95% of the cost of traditional long distance calls worldwide.

Net2Phone is integrated into the user interface of Netscape 7.0 for convenient access. The Full
configuration of Netscape 7.0 has the full Net2Phone application ready to run, and other
configurations allow you to easily obtain the product.

This program is available for Windows.
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The integrated Print Plus menu offers links to various printing services provided by Netscape and
Hewlett Packard (HP). These services make it easier for you to order business cards, school
supplies, special printing paper, printer cartridges, and other supplies online for your HP or non-HP
printer.
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The Viewpoint Media Player plug-in is a leading provider of rich media visualization technologies on
the Web.  Viewpoint enabled content takes advantage of Viewpoint Experience Technology (VET)
to provide high fidelity visuals in low bandwidth environments.

The plug-in is available for all installation configurations for the Windows Platform.
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Tools to simplify cross browser development

Netscape realizes it is expensive for Web site developers to develop and maintain separate Web
pages for different browsers. Developers are also acutely aware that pages coded using non-
standard, proprietary techniques often do not display as intended. To help in the transition to
standards-based pages, Netscape DevEdge (http://devedge.netscape.com) delivers tools,
documentation, a knowledge base, and an active online community for building Web content that
works in Netscape and Microsoft browsers, CompuServe 7.0 as well as other browsers that embed
Netscape Gecko. On DevEdge, developers can sign up to get updated news and information on
Web development and collaborate with industry experts and other Web site developers.

Chapter
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Netscape DevEdge offers a simple tool for site developers to test and update their Web sites so the
pages display correctly with all leading browsers. Novice or intermediate Web authors can use the
DevEdge Web Tune Up Wizard to walk through the process of validating a Web page—making it
easy to diagnose code issues. Developers will also receive pointers on backward compatibility with
Netscape Communicator 4.x browsers.

The Netscape Gecko Browser Compatibility Handbook informs developers about coding strategies,
as well as commonly encountered problems, the causes, and available solutions to make the
development process more productive.
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DevEdge guides developers in building Web pages based on open standards—so the same site
code can work for Netscape 6 and 7, Microsoft Internet Explorer, plus any product that embeds
Netscape Gecko such as CompuServe 7.0.

For many developers, cross browser support simply means using HTML and JavaScript. DevEdge
includes robust documentation and tools for developing more sophisticated content and applications
with open standards. That includes HTML 4.0, CSS 1, CSS 2, DOM 1 & DOM 2 (Core and HTML),
RDF, XML 1.0, XML Namespaces 1.0, XML data exchange, transformation of XML documents with
XSLT, XPath 1.0, XHTML 1.0, JavaScript 1.5 and more.

DevEdge also hosts a rich archive of articles and information to assist developers in sharing as
much code as possible across all the browsers they need to support.  Moreover, DevEdge helps
developers take advantage of new Netscape 7.0 browser features such as the built in XSLT
processor which gives sites a great way to transform and present XML documents on the fly.

����������������
0
����
������)
������'���

DevEdge has its own My Sidebar Tabs which developers can add to their Netscape browser.
These tabs offer quick reference to key technologies such as CSS2 and HTML 4.01 so they can
continue coding without leaving the page they are working on.  The User Agent String Tab for My
Sidebar expedites site testing, by enabling developers to see with one click how code will display in
a Gecko-based browser.

In addition to DevEdge tabs for My Sidebar, developers can learn how to create and deploy their
own tabs; this development can be done in as little as 15 minutes.
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The leader in Internet technology has built the foundation for the next
Internet revolution
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Netscape Gecko is the embeddable cross-platform browser engine at the heart of Netscape 7.0.
Netscape Gecko provides content rendering and support for Web standards such as HTML, XML,
Cascading Style Sheets (CSS), the Document Object Model (DOM), and JavaScript. To ease the
creation of desktop applications and devices that embed Netscape Gecko, it also features a cross-
platform, cross-device architecture and powerful technologies such as the XML-based User
interface Language (XUL).

Netscape Gecko is developed as part of the Mozilla.org open source project, and is freely available
for inclusion in third party products.  In addition to Netscape 7.0, Netscape Gecko is found in a
variety of products from AOL (such as CompuServe 7.0) and other companies. Netscape 7.0 uses
Netscape Gecko to deliver the most advanced, standards-compliant browser across platforms, and
the ease of embedding Netscape Gecko brings the same power to desktop applications and
devices as well.  Netscape Gecko is the core browser component in Mozilla 1.0, the first major-
version public release of the Mozilla software.  The release of Mozilla 1.0 signals a level of
compatibility and maturity of the programming interfaces provided by Netscape Gecko, and heralds
the arrival of new Gecko-based products.
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By virtue of embedding Netscape Gecko, Netscape 7.0 supports more Web standards, more
deeply, more consistently across more platforms than any other browser.  Netscape 7.0 features
support for HTML 4.0, XML 1.0, Resource Description Framework (RDF), Cascading Style Sheets
level 1 (CSS1), and the W3C Document Object Model level 1 (DOM1). Netscape 7.0 also has the
industry’s best support for Cascading Style Sheets Level 2 (CSS2), the Document Object Model
Level 2 (DOM2), and XHTML. Standards support also includes XML data exchange and
manipulation of XML documents with SOAP 1.1, XSLT, XPath 1.0, and FIXptr. Finally, it features a
solid foundation of support for data transport protocols (HTTP, FTP, and SSL), multilingual character
data (Unicode), graphics (GIF, JPEG and PNG) and the latest version of the world’s most popular
scripting language, JavaScript 1.5.

Software and device vendors, content and Web application developers, and consumers will all
benefit from this full-power platform for Web standards.

Appendix
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•  HTML 4.0 supports the creation of Web forms that are easier to understand and tables that
are easier to read.

•  XML 1.0 enables the representation and exchange of structured documents and is a key to
Internet commerce.

•  Cascading Style Sheets (CSS) make it possible to richly format Web pages while
simultaneously separating format and content for easy authoring and maintenance.

•  The Document Object Model (DOM) makes objects on the page accessible to the
JavaScript scripting language and allows scripts to edit or reformat the page and to respond
to user events.

Together, these standards enable the creation of richer Web content and higher-performance, more
interactive, and more powerful Web applications that can be used on a wide range of platforms.
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Netscape 7.0 delivers the standards support that Web developers demand. The World Wide Web
Consortium (W3C) standards at the core of Netscape Gecko provide a robust foundation for cross-
platform, cross-browser, cross-device Web content and applications. Because standards are stable
over time and under the control of neutral standards bodies, developers also gain investment
protection for their work and products in the future.

•  Developers can write content and Web applications once, and they will run on any standards-compliant client
application. In particular, they will run on browsers and devices that embed Netscape Gecko, reaching a
broad audience across a variety of platforms.

•  Because Netscape Gecko implements W3C standards, time and money won’t be wasted
on developing workarounds for holes in standards compliance.

•  The power of a Web content and application platform now rivals that of proprietary platform
APIs (such as the UI and event handling supported by Microsoft Windows), so that Web
applications can offer the richness and power once only possible for platform-specific client
applications. In the long term, companies will compete to create full-power Web
applications to replace traditional client-side desktop applications and will aggregate
multiple Web applications to create user environments matching the desktop in power and
exceeding it in access to real time Internet data and in ease of use.

•  Netscape Gecko’s rich support for Cascading Style Sheets enables content developers to achieve formatting
controls that approach those of traditional desktop publishing applications.

•  By using Cascading Style Sheets formatting rules and positioning instead of <FONT
FACE=> elements and TABLEs, content developers can also slash the size of Web pages
by up to 95%, dramatically reducing page download times on their site.

•  The clean separation of content and presentation enabled by Cascading Style Sheets
makes it easier and cheaper to maintain and update a site’s look and feel over time.
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•  By building DOM-based applications that do more processing on the user’s computer,
developers can reduce the number of server round-trips necessary per session. This
provides better performance to the user while simultaneously reducing load on servers and
cost for the content provider.

•  Within the My Sidebar tabs of Netscape 7.0, portals and content sites can immediately use
the full power of Gecko to offer compelling My Sidebar tabs with timely information, links,
services, and notifications. This will integrate the site more deeply and permanently into the
user's browser and daily work, increasing user loyalty and return visits.

��0���������������
���
�����������	
�

In addition to broad, cross-platform standards support, Netscape 7.0 and the Netscape Gecko
layout engine feature an architecture that is open, portable, extensible, and customizable. This
architecture makes it easy to support a wide variety of platforms and devices, add rich functionality,
and integrate it all with the popular JavaScript scripting language.

•  Gecko's foundation is a set of XPCOM modules. XPCOM is a cross-platform
implementation of the well-known Common Object Model (COM). Developers can easily
extend the browser's core capabilities by adding their own XPCOM components.

•  To make these binary components scriptable from JavaScript, Netscape Gecko supports
XPConnect. With XPConnect, anyone who can write JavaScript can take full advantage
and have full control of all the power that XPCOM binary components offer.

•  To provide up-to-the-minute support for the latest Java Virtual Machines (JVMs), Gecko
supports the Open JVM Interface (OJI). This clean, plug-in based architecture decouples
Gecko development from JVM development, allows Gecko users to upgrade to a new
version of a JVM as soon as it is released, and gives them the freedom to choose any OJI-
compliant JVM on their platform or device. It enables Web content and applications to make
full use of the vast and growing library of existing Java applets.

•  LiveConnect makes it possible for JavaScript to control Java applets and smoothly
integrate them into Web content and applications.
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•  The entire user interface of Netscape 7.0 is implemented in XUL, the XML-Based User
interface Language. XUL makes it easy to build a cross-platform software application user
interface by leveraging all the power inherent in the Web standards (HTML, XML, CSS, and
DOM) and adding in common user interface metaphors such as boxes, springs, and other
layout constructs.

•  The XP Widgets are a pre-built library of user interface objects for use in XUL. These
widgets include common user interface objects such as menu bars, toolbars, tree widgets,
tab widgets, progress bars, and so on. They make it even easier to build a powerful cross-
platform user interface.

•  XBL, the Extensible Bindings Language, allows developers to modify the behavior of
existing XUL widgets and to extend the set of widgets available.  Developers have the
power and flexibility to deliver user interface elements custom designed for their particular
applications.

•  The Mozilla Plug-in API provides access to the power of today’s leading browser plug-ins,
as well as future plug-ins.
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More and more software applications need the ability to display Web content for help, for the
preview of output that has been formatted for the Web, or for other purposes. Also, the next few
years will bring a proliferation of devices for browsing the Web. Vendors can build their products
more quickly and easily by embedding Netscape Gecko and offer their customers full power Web
browsing at the same time, without being tied to a particular operating system.
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•  Netscape Gecko's Web shell embedding API makes it easy to integrate into any
application.  In addition to Netscape 7.0, Netscape Gecko is embedded in other AOL
clients, including CompuServe 7.0, as well as in the products of a variety of other
companies.

•  The release of Mozilla 1.0 signals to developers a level of maturity and support for the
Netscape Gecko APIs.  Combined with broad distribution of Gecko-based products, this
ensures that vendors’ development investments are preserved as their products evolve.

•  Netscape Gecko is free, so application and device vendors can add support to their product
for all these Web standards with zero licensing or distribution costs.

•  Because of Netscape Gecko's cross-platform, cross-device architecture, vendors can easily
use Netscape Gecko on a wide range of platforms or devices.



<<
CONFIDENTIAL UNTIL THE PUBLIC AVAILABILITY OF
NETSCAPE 7.0

Appendix

�1

)������%�/�
�������
                    

  

Netscape 7.0 Requirements

Windows Operating
Systems

Windows 98, 98SE,
Windows ME,
Windows NT 4.0,
Windows 2000,
Windows XP

     Minimum
Hardware

233 MHz
64 MB RAM
26 MB hard drive space for minimum install

Mac Operating
Systems

Mac OS 8.6 or later, Mac OS 9, Mac OS X

 Minimum
Hardware

PowerPC 604e 266 MHz or faster processor,
G3, or G4
64 MB RAM
36 MB hard drive space 

Unix Operating
Systems

Linux kernel-2.2.14 or greater, with the
following libraries or package minimums:  

•  glibc - 2.1.0
•  gtk+ - 1.2.0 (1.2.5 or greater

preferred)
•  XFree86-3.3.6

Supported Platforms:
Netscape has been certified and is supported
on RedHat Linux 6.2, 7.0, 7.1, 7.2 and
greater.

 Minimum
Hardware

233 MHz
64 MB RAM
26 MB hard drive space


